
Welcome to Cubase way of Making Music
There is some essential information included in this file to help you make effective use of the 
Cubase for Windows Demo Program. Please read this file through before using Cubase. By doing
so you will get a better understanding of what Cubase can do. This file is has three main sections.

System Requirements: What kind of hardware will you need.
Cubase Installation: Getting the Cubase ready to Go.....
Your First Recording: Your first steps in Cubase operation.

Have fun but please remember, Cubase is supplied with a illustrated manual with over 350 pages,
this file can only hint at whats possible.

System Requirements
Your Computer
To run this program you need an MS-DOS compatible 386 SX (or better) that runs at 16 MHz
or faster. You need a VGA or Super VGA compatible display with gray scales or colours. The
minimum amount of FREE RAM is two megabytes. That is not the same as a computer with two 
megabytes of actual RAM present. After all your extensions are loaded, Cubase needs two 
megabytes.  You also need a hard disk, a mouse and a MIDI interface.

MIDI Interfaces
You can use Cubase with different interfaces. There is direct support for many different
models, directly within Cubase. Others may be supported via Multimedia Extensions. If any
interfaces have been added to the list since this file was written, you will find
information about them in the READ_ME document that may have been added to this disk.

Windows
This program runs under Windows, version 3.1 or later. We recommend you to use 3.1 or
later. If you have a computer that runs at at least 33 MHz with hardware hard disk caching,
you can run Windows in 386 Enhanced mode (also called "/3" mode). Otherwise, please use
Standard mode (also called "/s" mode).

Disk
The program comes on one 3.5" DS DD disk. It is not copy protected.

"Read Me" Files
You may find a "READ_ME" file on your hard disk after installation of the program. This is a
text file which describes any changes or additions to the program. Use any word processor or text
utility (such as the Notepad or Write program that come with Windows) to open it and read its 
contents.

Note Off Controllers
Some Roland synthesizers send a MIDI message called All Notes Off as soon as you release
all keys on the keyboard. This may lead to very confusing results when the same synth is
used to play back music from more than one Track. If you experience this problem you
should filter out this message using the Controller filters in the MIDI Setup dialog box.

Running Status
There is a way to make MIDI transmission more compact, called Running Status. This was
not a part of MIDI from the beginning so not all units can accept this data compression



method. If you experience problems with a Korg DDD1 or DDD5, an Ensoniq Mirage, a
Sequential Prophet T8 or a very old Yamaha DX7 you should make sure that you are not
transmitting under Running Status from your computer. Check the setting in the MIDI Setup
dialog box. It will be obvious if you have this problem since the instrument will hardly play
back sequenced material at all.

Cubase Installation
If your computer isn't already set up as it should be, do so, following the instructions in the 
computer's Operation Manual. Install the MIDI interface you plan to use and turn it on if needed.

Install Windows and verify that it works as expected. If you plan to use Multimedia Extensions you
should familiarize yourself with its concept by reading the Windows manual.

Make yourself reasonably familiar with operations like handling disks and using the mouse 
(clicking, selecting, double-clicking and dragging).

The following text assumes that you are using a one MIDI In, one MIDI Out interface. If you have 
a more advanced type, or are using several interfaces, we can't make any definite suggestions on
how you should connect your gear. Please refer to the interface manual.

Connect the MIDI Out of the keyboard (or other MIDI device) you plan to use for recording, to the 
MIDI In of the computer.

Connect the MIDI Out of the computer to the MIDI In of the first instrument. Then connect the 
MIDI Thru of that instrument to the MIDI in of the next device. Continue to chain the units in this 
way until they are all connected to the computer. If you plan to use more than three sound 
sources we recommend that you use a separate MIDI Thru box instead of the Thru jacks on each 
unit. If more than one instrument doesn't have a MIDI Thru, you will have to get a MIDI Thru box.

Make all audio connections, turn on the instruments and verify that they sound (if possible).

Set each instrument to receive on a certain MIDI Channel. Or if you have multi-timbral 
instruments, set each sound (Timbre, Part, Program, Patch) to receive on a certain MIDI Channel.

Installing the Program on the Hard disk
Cubase comes on one 3.5" DS DD floppy disk. The files on it are compressed and put in an 
"archive file". There is a special Installation procedure that unpacks all the files and puts them in 
the right places, automatically. You might not need all the files that are generated, but it is very 
important to have the ones you use in the right directories.

Start the computer, and make yourself a backup copy of the original disk as it is when it comes 
from the factory (how to do this is explained in your DOS and Windows manuals). Put the original 
in a safe place (you might need it at a later stage) and do the installation from the backup.

Make sure Windows is not running. If it is, Exit it. The Windows manual will tell you how to do this.
You should now see the so called DOS prompt at the screen:

C:\>_

Make sure you have at least two megabyte of free disk space (you should actually have 
substantially more to be able to store your songs on your hard disk).

Insert your copy of the Cubase disk in any floppy drive. This could be either the "a:" drive or the 
"b:" drive depending on your computer. If you only have one floppy drive, it will be the "a:" drive. If



you have two it might be either, check the computer's operation manual if in doubt.

Type "a:" or "b:" (you should of course omit the quotes and just type an "a" or a "b" and a colon) 
depending on which drive you put the disk in. Press [Return]. The computer should respond with 
A:\>_ or B:\>_. If it doesn't, you somehow didn't put the disk in the right drive or mistyped. You 
have now selected the floppy drive with the Cubase disk as the active drive.

It is now time to unpack the files and copy them to the hard disk. This is done by typing "install c:\
cubase" (exactly like that, with one blank between "install" and "c"). Press [Return]. 
This line means: Use the information in the "install" file to copy the files to the "cubase" directory 
on drive "c:".

If you know your MS-DOS and for some reason wish to copy the files to another directory, you 
may specify another path name or another drive. However, in the rest of this manual, we assume 
you followed our recommendations and put the files in a "cubase" directory.

The program will now create a "cubase" directory (if none exists), unpack each file on the floppy 
and copy it to the directory. The screen informs you of the progress. When done, the screen 
shows "Cubase Installation finished", and the A:\>_ prompt comes back.

It is now time to start Windows. This can probably be done by just typing "win/s" and pressing 
[Return]. This starts Windows in "Standard Mode", which is your best bet, it will work on all 
computers. You may also type "win/3" and press [Return] to start Windows in "386 enhanced 
mode", if you really need the features of this mode. Windows will always run slightly faster in 
Standard mode.

Once Windows is running it's time to make up a Program Group to put Cubase in, if you don't 
already have one. Pull down the File Menu and select New. Select the Program Group option and
click OK. A dialog box appears:

Type a name you would like to use, on the Description line. "Cubase" is what we suggest (and 
what this manual assumes), but maybe you would like it to be called "Music" or something else, it 
doesn't matter to running Cubase. Keep the name short.

Click on OK. A Group file is automatically created (you don't even see it happening) and the new 
Program Group appears as a window in the Program Manager Window.

Select New again, but this time, select Program Item and click OK.

In the new dialog that appears, click on Browse.



Now you have to locate the Cubase directory on your hard disk, that was created when you 
installed the files on the hard disk. If you followed our recommendations about naming and 
positioning, you first double click on the open folder icon followed by the text "c:\" in the 
Directories list and then double click on the closed Cubase folder icon that appears in the 
Directories list. The path name after (or below) the "Directories:" text should now read "c:\
cubase", if you put the files where we recommended. There should also be an open folder icon 
called Cubase, in the Directories list. 

In the file list to the right in this dialog box, you will find two files called "cubase.exe" and 
"setup.exe". We will now create Program Items for both these files, but one at a time.

Double click on the text "cubase.exe" in the file list to the left. Click OK in the next dialog that 
appears. You should now have a window on screen, with a Cubase icon in it.We will now create a
Program Item for the Setup program that accompanies Cubase. Create a Program Item as for 
"cubase.exe" (Select New from the File menu, select Program Item, etc, as described above) but 
this time, double click on "setup.exe" in the file list instead, and click OK in the dialog box that 
appears. You should now have a window with two Program Items, Cubase and Setup.

It is now time to "tell" Cubase what MIDI interface(s) to expect, or "ask it" to use Multimedia 
Extensions for Windows (hereafter abbreviated MME). 

We do not mean to discourage you, but there is a multitude of PC- models out there and a 
MIDI interface interacts with the computer on a pretty low level. If you are unlucky you might 
run into problems when configuring for the interface, problems that require you to familiarise 
yourself with such technical terms as base addresses and interrupt request levels. Please 
make your Setup settings very carefully to avoid potential problems. If in doubt, contact an 
expert.

Double click on the Setup program icon. The program launches, and automatically displays the 
Device Configuration window.



This is a simple program displaying a list of available driver routines, software need for using 
Cubase with a specific MIDI Interface. If there are many drivers available, the list can be scrolled. 

When you click on one of these drivers, it gets selected and a number of settings for it appears to 
the right. The only common setting for all drivers is the Active check box. If this is crossed, a small
dot appears to the left of the driver file name indicating that it is active. There are two ways to 
activate a driver, click once on it and make sure the checkbox is crossed, or simply double click 
on the driver name. All the currently active drivers have a small black dot to the left of their 
names.

Now use the methods outlined above to make sure the drivers you plan to use are active (and 
that all else are deactivated!).
For many of the drivers you have to fill in some values (serial port, base address, IRQ and what 
not). This is described for each type of interface below.

Some interfaces can be used at the same time as others, but not all. As for exactly which 
combinations of interfaces will work, only experimentation can tell.

Once you have activated the driver(s) you plan to use and have made all the settings for it (them) 
you can click OK.

Select Exit from Setup's Options menu.

Double click on the Cubase program icon. A startup screen appears, Click on it to make it go 
away. Cubase starts, displaying an Arrange window with the title Untitled plus a Transport Bar 
with some tape recorder like controls and a number of buttons.

If the program has a problem establishing contact with an interface, a dialog box will inform you. 
Please Quit the program, and use Setup to check your Interface installation again.

Observe: This doesn't apply to interfaces connected to the serial ports of the computer, 
such as the Key Electronics Midiator series. Cubase has no way of telling if serial port 
devices are properly connected and functioning. 

There is a number of reasons Cubase might not be able to establish contact with an interface:

The interface is not properly connected.
The interface is not turned on or is not receiving power.
You haven't done the correct settings for this interface in the Setup program.
There is something wrong with the interface.



There is also a way of seeing directly in the program if the Cubase has proper communication 
with the interface: 

If you pull down the Output menu for a MIDI or Drum Track, a list of available Outputs will appear.
If some interface is missing completely in this list, the driver file somehow didn't get activated. The
interface itself might be properly installed.

If one or more of the Output list items are grey, Cubase will have loaded the driver but for some 
reason can't establish any contact with that interface. This does not apply to serial port interfaces 
as stated above.

Before you go on, make sure that your MIDI Thru setting is correct. If you use a synth for 
recording, set your synth to Local Off if possible, and check the Thru Active box in Cubase's MIDI 
Setup Dialog box on the Options menu.

If you use a separate MIDI device like a MIDI keyboard with no sounding capabilities, a guitar to 
MIDI converter with no built in synth or similar, Cubase should also be set to Thru Active. If you 
use a synth or similar that can't be set to Local Off, the options are a little bit more complicated 
due to the nature of MIDI.

Play your MIDI keyboard or other device. Check the "IN" box on the Transport Bar so that you are
sure that Cubase receives MIDI data. If you have Thru activated, the "OUT" box just below it 
should indicate Output of data also.

The IN and OUT symbols on the Transport Bar indicate MIDI In and Out activity.

If the Installation was successful on all points you may now proceed to the next section, Your First
Recording! 

Changing Interface Settings
If you later buy another interface or replace the one you have, you may need to select another 
driver file.

Make sure you have Quitted Cubase.

Start the Setup program.

If the Device Configuration window doesn't appear automatically, select Configuration from the 
Options menu.

Make all the necessary settings as described above and below.

Click OK, and select Exit from the Options menu.

Start Cubase, and use the procedure outlined above to make sure you have proper contact with 
the interface.

Songs you made with the old drivers will now output to the ports of the new Interface. you 
may have to set the Tracks to new Outputs to make the Songs play back as they did with 



the old interface.

Supported Interfaces

Here's information about the currently supported interfaces and the settings in Setup for each one
of them. Information about interfaces that are supported, but not found in the list below can be 
found in a READ_ME document that you may find in the Cubase directory after installation.

When the Interface requires you to set a base address and an IRQ, please make absolutely sure 
you here enter the same settings as are actually done on the interface.

MPU-compatible interfaces
Cubase supports all MPU-compatible interfaces. It uses them in UART mode, which means that 
all timing is handled by Cubase, not the card. Any metronome on the card is not supported, 
Cubase instead uses the sound capabilities in the computer to produce a click.

For installation details we refer to the documentation that came with the card.

When you install the MPU interface driver you have to set a base address and an IRQ Level. 

These are two settings that are also done on the card, probably with so called dip switches. The 
most widely used values are base address 330 and IRQ Level 2, but you will have to check the 
documentation that came with the card. It is absolutely imperative that the settingson the card 
and in the Setup program are identical, or Cubase won't recognise the card (or you may get even 
worse problems).

Steinberg SMP-II
This is a 2 in, 4 out, rack mounted MIDI interface with direct support for time code. It allows you to
output on up to 64 separate output MIDI channels and to use Multi recording with separation from
the two inputs.

How to install and configure the SMP-II is described in the manual that comes with the unit, but 
you have to make a base address and IRQ Level in Setup. The default values are IRQ 7 and 
Base address 300.

Mark of the Unicorn MIDI Time Piece
This is a 8 in, 8 out, rack mounted MIDI interface with direct support for time code. It allows you to
output on up to 128 separate output MIDI channels and to use Multi recording with separation 
from the first four inputs.

How to install and configure the MTP is described in the manual that comes with the unit, but you 
have to make a base address and IRQ Level setting in Setup. The default values are IRQ 2 and 
Base address 340.

Key Electronics Midiator MS-101
This is 1 in, 1 out interface that is connected directly to the serial port of your computer. It is 
designed especially for laptop computers where it is necessary to have the interface outside the 
computer, but it can be used with any PC model. The only setting necessary for it is the number 
of the serial port you choose. 



There is no way for Cubase to tell if the Midiator is correctly connected to the computer. 
Therefore, it is always displayed in black in the Output pop-ups in Cubase if the driver is 
activated.

Key Electronics Midiator MS-103
As above, but with 1 in and 3 out, allowing for Output on up to 48 separate MIDI Channels.

Creative Labs Sound Blaster Pro
This is actually a card for playing back digital audio, but it also incorporates a 1 in 1 out MIDI 
interface. Cubase does not support the audio part of the card, only the MIDI part.

How to install and configure the Sound Blaster Pro is described in the manual that comes with the
unit, but you have to make a base address and IRQ Level in Setup. The default values are IRQ 5 
and Base address 220.

Fostex 
This is a driver for communication with the Fostex R8, G16 and G-24S tape recorders. You can 
only use one of these at a time. The driver is not used for sending or receiving regular MIDI data 
as the other MIDI interface drivers are. Instead, when you have it installed, a "Fostex" item 
appears on the "Timebase" menu in the Synchronization dialog box. This allows you to use Tape 
Tracks with the above mentioned recorders. There is one setting for this driver, the number of 
Tracks on your tape recorder. For the R8, set it to 8, for the 
G-16 set it to 16, etc.

Multimedia Extensions
Multimedia Extensions (MME) is not a physical interface, but rather a part of the operating system
Windows 3.1 (or later). Selecting this means that MIDI data is sent from Cubase to Windows 
which then transfers it along to an interface or another program. The main reason for using MME 
is when you want to use an interface for which there is no direct Cubase support, but for which a 
so called "MME driver" exists.

Other Files in the Directory 
When you installed Cubase on your hard disk, a number of files were copied to a Cubase 
Directory. Most of these are necessary for running Cubase, but some of them are example files 
and other files of interest to all users.

DEF.ALL is a settings file, a Song which will be automatically loaded on startup. If you load this 
Song, change some settings in the program and save the Song again under the same name, you 
have customized Cubase's settings.

DRUMSETS is a directory containing yet other directories with ready made drum maps for a 
number of drum machines and synthesizers on the market. Please use the Open File feature with
File type Drum Map selected, to load one of these drum maps.

There might be a READ_ME file in the Cubase directory, containing vital information about 
changes to the program since this manual was written. Open it using any word Processor or Text 
Editor.

There will be a set of Groove maps, supplied by DNA, included with the program. See the 
READ_ME file for more information about this.



Advanced Information
The files. For those who have the need, we here describe the other files in the Cubase directory. 
You don't need to read the following text to use the program.

CUBASE.EXE is of course the program itself. To be able to use it you also need two files called 
MROSDLL.DLL and CUBASE.INI and two folders called FONTS and MROS. Do not move these 
folders and files.

The MROS folder contains the drivers for Devices you can use. If you for instance have a 
Steinberg SMP-II, you need to have a file called MR_SMP2.DLL or MR_SMP2.DL in your MROS 
folder. 

When a driver is active its extension is "DLL", when it is inactive its extension is "DL". You use the
program Setup (the file SETUP.EXE in the Cubase directory) to make a driver active/inactive. 

The driver files are very small, but if you absolutely need to, you can remove the ones you don't 
need.

In the Cubase Directory you should also find a file called DEF.ALL. You should definitely keep the 
DEF.ALL in the Cubase directory, because this will make the program start with some sensible 
settings. You can later alter this file from within Cubase and thereby customize the settings of 
program.

Your First Recording
This section gives you a short introduction to how recording is done in an Arrange window in 
Cubase. This text does not give you all the details.

This text assumes that you have already followed the steps in the "Installation" section, that you 
are using a regular one port interface, and that you have no problems with the MIDI Thru setting. 
You should have the default Arrangement in the DEF.ALL song that came with the program, 
displayed on the screen. This gets automatically loaded when you start the program. This text 
also assumes that you have one or more MIDI instruments, each set to one MIDI Channel, or that
you have a multitimbral instrument (or several), with each sound set to one MIDI Channel.

Play your keyboard and check the IN box on the transport bar. It should flicker to indicate that 
Cubase is receiving data. If you have Thru turned On (in the MIDI Setup dialog box), the OUT box
flickers along, indicating outgoing data.

On the left side of the screen you have the Track List. It now displays 16 Tracks set to send on 
MIDI Channel 1 to 16. Use the right (increase) and left (decrease) mouse buttons to set the first 
Track to the right MIDI Channel by changing the value in the "Chn" column.



Once you've got the setting right, double click in the "Instrument" column on that first Track. A 
small box opens up where you can enter a name for the sound or instrument you use. Do this and
press [Return] when you are finished.

If you dont see the instrument column, maybe you need to move the window divider. Locate this 
thin vertical double line and grab it with the mouse. Dragging it to the left or right will show more 
or less information about the tracks.

If you want to change the tempo, locate the Tempo box on the Transport Bar, and change the 
value using the left and right mouse button.

Click on Record or press [*] on the computer keyboard.

After the two bar count-in, start playing for as long as you wish. When you are finished, click on 
the Stop button or press [0] on the numeric part of the computer keyboard. A black rectangle 
should be displayed on the first Track. This is a (selected) Part, a recording on a Track. A Part can
be dragged around on the screen. If you hold down [Alternate] while dragging you are making 
copies (duplicating).

Press [0] on the numeric part of the computer keyboard twice so that you return to the beginning 
of the Song.

Click on Play or press [Enter] to play it back. If you wish, you can use Rewind or Fast Forward at 
any time to move back and forth without stopping first. If you decide to Stop first, you can use 
Fast Forward with the right mouse button to hear the music played back in a faster tempo 
(cueing).



After playing back the Track, return to the beginning of the Song again.

Select a new Track by clicking on it.

Set it to the MIDI Channel for the next sound you wish to record with, and enter an Instrument 
name for that also.

Record on the second Track just as with the first.

If you make a mistake somewhere there are many ways to go, but we will only suggest two of 
them here. Either just press [Control]-[Z] on the computer keyboard to make the last recording 
undone (you can even "undo the undo" if you like). Or if you want to "repair" a section of your 
recording, use the Rewind and Fast Forward buttons to move to some point before that section. 
To tell Cubase that you want to Replace music rather than Overdub on the same Track, click once
on the Rec Mode switch on the Transport bar, so that it changes to "Replace". 

Play back the music. At any time, click on Record or press [*] to enter recording. Click again to 
exit record mode without stopping playback. Rewind again if you need to (in Play mode) and 
Punch in and out as many times as you wish.

Click on the Record Mode switch once so that you put Cubase back in Overdub mode.

If you want to Quantize a recording, (remember that you don't have to stop playback or even 
recording to do this) first set the right Quantize value. There is a box at the top of the screen 
labelled Quantize. If you press the mouse button inside that box, a menu falls down where you 
can select a Quantize value. This value is valid until you change it.

Now select a Part by clicking on it. Then pull down the Functions menu and select Over Quantize 
or press [Q] on the computer keyboard. You can select several Parts to be Quantized at the same
time if you hold down [Shift] while clicking on them.

Continue to record more Tracks. If you want to use an instrument or a sound that has been used 
before, press any mouse button in the Instrument column, and select that instrument/sound from 
the menu that falls down. The Track is then automatically set to the right MIDI Channel.



If you want to make a recorded Track send out on another MIDI Channel, just change the "Chn" 
value for that Track.

If you want recording with a count-in (Precount) to start from some other point than the beginning,
click in the Bar Display (above the Parts) at that position, using the left mouse button. What you 
do is to change the setting of the Left Locator, and the new setting is shown numerically in 
another box on the Transport Bar.

The Parts that are created can be moved freely between Tracks and duplicated if you wish. They 
can also be split, joined, copied, repeated, lengthened shortened, grouped and much more. And 
all this while the music is playing! If you press the right mouse button somewhere in the Part 
Display, a Tool Box appears that you might want to experiment with. 

If you want to delete one or more Parts, select them as with Quantizing and press [Delete] on the 
computer keyboard.

Normally when you are happy with your piece, you would pull down the File menu and select 
Save As... (no, you don't have to stop playback to Save). Click on Filetype "Arrangement" in the 
dialog box that comes up. As this is the DEMO version of the Cubase for Windows Program, you 
cannot save your music.

Select New from the File menu to get a new Arrangement window. This has no Tracks yet.

Double-click anywhere in the Track column, and a new Track appears. You can create as many 
Tracks as you wish in this way.

This time you don't have to create Instruments, they are already there when you press the left 
mouse button in the Instrument column. Select an Instrument for the first Track you wish to record
on, and select that Track by clicking on its name.

You are now ready to try the absolute fastest way of making up grooves or short sections of 
music you ever experienced-cycled recording in Cubase. This time you will record four bars, but 
the Cycle could be any length. Check the Left and Right Locator boxes on the Transport Bar, they
should say 1.1.0 and 5.1.0. If they don't, press the function key [F1] on the computer keyboard.

Click on Cycle on the Transport bar.



Click on Record.

It is unnecessary to deactivate recording at any time during the following procedure. You 
can deactivate recording at any time by clicking on the Record button, if you want to, but 
you don't have to!

Start playing after the two bar Precount. The music Cycles over the four bars and you can add as 
much as you want on each lap.

When you so wish, select a new Track and record on that. Use the "Instrument" column to make 
each Track output to the right sound/instrument. If you need to, make up more Tracks by double-
clicking.

You can Quantize, move Parts and duplicate as you wish and also select new instruments or 
MIDI Channels for each Track at any time.

If you make a mistake, press [B] to delete the whole recording on that Track or [V] to just delete 
the last lap you played anything on. And if you come up with anything good, remember to save it 
to disk!

When you have something you are almost satisfied with, double click on it. A new window opens 
with a piano keyboard at the left side and a Position Bar just like the one in the Arrange window at
the top. You will here see some or all of the notes you recorded, displayed as on a piano roll.

If you wish, you can keep playback going in a Cycle. If you find the automatic scrolling disturbing, 
use the Options menu to turn "Follow Song" off (no tick).

If you want to hear the edited Part only, during playback, activate "Ed Solo" on the Transport Bar.

Use the scroll bars to locate some notes you want to work on. Press the right mouse button to 
bring up the Tool box. With the mouse button pressed, select a Tool. Use this Tool in the display, 
with the left mouse button. Here are some hints:

The Arrow Pointer is for selecting and moving.
The Pen is for drawing and lengthening/shortening.
The Eraser is for deleting.
The Kickers are for kicking notes around.

When you are finished editing, click on the Control-menu box in the window's title bar, and select 
"Keep" from the menu that appears. This closes the window and makes your edits "permanent". 
(You can also do this by double clicking on the Control menu icon or by simply pressing [Return].

Following this short description, you have of course barely scratched the surface of Cubase's 
power. But you have probably gotten a feel for how simple it is to use. Continue to experiment 
and try out functions as it suits you. Some things you will have to read in the manual about, and 
other things will be obvious from the start. But the way this program works, your intuition will 
always put you on the right track. Good Luck!


